
Course Description Form

1. Course Name

Computer - First Stage

2. Course Code

SESS26F1051

3. Semester/Year

2025- 2026

4. Date of preparation of this description

February/ 2026

5. Available Attendance Forms

Presence / Theory and Practice

6. Number of credit hours (total) / number of units (total)

2 hours per week / 2 units

7. Course administrator's name (if more than one name is mentioned)

Assist. Prof. Dr.Mohammed Hazim Alkawaz mohammed.ameen@uomosul.edu.iq

Lect. Rehab Joko Hussein

Assist. Lecturer SaifKhalid Jarallah
Assist. Lect. Salwa salah aldeen Qasim

Assist. Lect .ghazwan mohammed

8. Course Objectives

rehab@uomosul.edu.iq

saif.al.saaty@uomosul.edu.iq.

salwa.kasim@uomosul.edu.iq

ghazwan.mohammed@uomosul.edu.iq

Course Objectives

1.

2.

3.

The students learned personal computer (PC) skills, performed various

tasks on the Microsoft Windows 10 system and the Microsoft Office
2019 applications (Word 2019 and PowerPoint 2019), and became
familiar with modern technology in the sports field. Students learn skills
in using the personal computer (PC Computer), performing various tasks

on the Microsoft Windows 10 operating system, and using Microsoft
Office 2019 applications (Word 2019 and PowerPoint 2019), as well as
getting acquainted with modern technology in the sports field.
Knowledge of the computer applications that must be learned and used

for educational purposes. Knowing the computer applications that must
be learned and used for educational purposes.
The possibility of using the computer to create a positive and effective
impact in teaching various scientific subjects (theoretical and practical),
which is considered the main goal of the college to graduate teachers (in
general education and specifically in physical education). The possibility



of using computers to create a positive and effective impact in teaching
various scientific subjects (theoretical and practical), which is considered
the main goal of the college to graduate teachers (in general education
and specifically in physical education).

4. Developing the student's understanding of modern technology used to

enhance sports and athletic skills, as well as the concept of modern
education that stems from the educator's ability to use computer
applications that improve the student's concentration and observation
skills. Developing the student's understanding of modern technology
used to enhance sports and athletic skills, in addition to the concept of

modern education that stems from the educator's ability to use computer
applications that improve the student's concentration and observation
skills.

5. Employing computer applications in the educational and sports fields.
The use of computer applications in the educational and sports fields.

9. Teaching and learning strategies



Strategy

The learning and teaching strategies in colleges of physical education and

sports sciences are characterized by diversity, encompassing both
theoretical and practical aspects, and aim to develop students' knowledge
and computer skills.
These strategies typically include the following:

1. Student-Centered Strategies:
• Cooperative Learning: where students work in small groups to achieve

a common goal, enhancing mutual responsibility and positive
interaction.

• Problem Solving: Presenting problems that require students to apply
previous concepts and knowledge to reach solutions, encouraging
critical and creative thinking.

• Guided Discovery: Guiding students to discover skills or concepts
themselves thru a series of questions or tasks, instead of direct
nstruction.

• Peer Teaching: In this method, students within the same group
exchange information with each other under the supervision of the

professor, which enhances their understanding of the subject and
develops their leadership and teaching skills.

• Self-Instruction/Self-Check:It allows the student to relyon themselves
for learning and to evaluate their performance against a specific
standard for improvement.

2. Practical and Experiential Strategies Practical and Experiential
Strategies:

• Practical Learning Method: This is the most common method for
learning computer skills, and it includes the use of basic computer
applications.

• Simulation: Simulating mobile applications to understand the
similarities and differences.

3. Traditional and Modern Strategies Traditional and Modern Strategies:
• Lectures: Used to convey theoretical knowledge and scientific

concepts.
• Interactive Teaching: Encouraging interaction between the professor

and students thru discussions and asking questions.
• Technology Integration: Using modern technologies such as interactive

whiteboards, as well as electronic platforms and educational

applications.



10. Course Structure

Week

1

2

3

4

5

6

7

8

Required Learning
Hours Outcomes

Definition of the
computer and

explanation of the
methods of classifying

2 hours
the computer, its uses,
importance, and basic

components
(hardware).

Explanation of the basic

components (software),

types of data (file and
folder), and units of

2 hours
measurement for

storage capacity and
data transfer speed in a

computer.
Explanation of the hard

drive, computer speed
limitations;-computer¯

2 hours
components, laptop,
and general benefits of

computers.
Explanation of

operating systems in

general, and the
Windows operating2 hours
system in particular,

and the components of
the Windows operating

2 hours

2 hours

2 hours

2 hours

system interface.

Desktop explanation
(main icons,

background, and
taskbar)

Explanation of the file
explorer, and the
application of folder
creation, copy, move,
and paste operations
for folders and files.

Identifying file types,
and applying deletion,

Unit / Topic Name

Chapter One:
Introduction to
Computers,

Classification of
Computers, Uses of
Computers, Basic

Components (Hardware)

Chapter One: Basic

Components (Software)

Chapter One: Hard Disk,

ComputerSpeed
Limiters, Computers,

Laptop

Chapter One: Operating
System, Windows IO

Operating System

Chapter One: Desktop

Chapter One:
Explanation of File
Explorer (Creating a

Folder, Copying, Moving,
and Pasting)

Teaching
ethod

Delivering
the lecture

using the

smart board
and

discussion

Delivering
the lecture

using the

smart board
and

discussion

Delivering
the lecture

using the

smart board
and

discussion

Delivering
the lecture

using the
smart board

and
discussion

Delivering
the lecture

using the

smart board
and

cooperative
learning.

Delivering
the lecture

using the

smart board
and

cooperative
learning.

First Chapter Theoretical Exam / 1

Chapter One: Hidden
Files and Folders,

Delivering
the lecture

using the

Assessment
Method

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment



9

10

12

13

15

16

2 hours

2 hours

2 hours—

2 hours

2 hours

2 hours

2 hours

2 hours

restoration, and hiding
operations

Applying the process of
creating a shortcut file,
and the properties of
the file or folder.

Explanation of
Microsoft OneDrive and
its tool applications

(sharing and
synchronization)

Application for

installing and
uninstalling programs

of all kinds

- Installing and
uninstalling

applications from the
Microsoft Store app

Reviewing the
Windows system and

discussing the
differences between
computer systems,

tablet systems, and
mobile systems, and
distinguishing between
single-use and multi-

use and multi-tasking
systems.

Deleting Files and
Folders

Chapter One: Shortcut
File, File or Folder

Properties

Chapter One: Microsoft
OneDrive

Chapter One: Installing
and Uninstalling

Programs

Chapter One: Microsoft
Store

Chapter One: Types of
Systems

smart board
and

cooperative
learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

Delivering
the lecture

using the

—smart board
and

cooperative
learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

First Chapter Practical Exam / 1

First Chapter Theoretical Exam / 2

Mid-year Break

Explanation of
Microsoft Office 2019

applications,

introduction to Word,

Chapter Two: Microsoft
Office Word 2019

Delivering
the lecture

using the

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment

smart board
and



17

18

19

20

21

22

23

24

25

2 hours

2 hours

2 hours

2 hours

2 hours

2 hours

2 hours

2 hours

2 hours

the start window, the
main window.

Explanation of the
Ribbon, Application of
Tools (File Tab, Home
Tab - Clipboard Group)

Application of tools
(Home tab - Font

group)

Application of tools
(Home tab - Paragraph

group)

Application of tools
(Home tab - StyEes

group and Editing

group)

Application of tools
(Insert tab - Table

group)

Application of tools
(Insert tab - Tools -

Pictures, Shapes,
Header and Footer tool,
Page Numbers tool,

Text Box tool)

Chapter Two: Tab bar,

File tab, Home tab

Chapter Two: Home Tab
- Font Group

Chapter Two: Home Tab
- Paragraph Group

Chapter Two: Home Tab
- Style Set and Editing

Set

Chapter Two: Insert Tab
- Table Group

Chapter Two: Insert Tab
- Tools - Pictures,

Shapes, Header and
Footer Tool, Page

Number Tool, Text Box
Tool

cooperative
learning.

Delivering
the lecture

using the

smart board
and

cooperative
learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

Delivering
the lecture

using the
smart board

and
—cooperative

learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

Delivering
the lecture

using the

smart board
and

cooperative
learning.

Second Chapter Practical Exam / 1

Second Chapter Theoretical Exam / 1

Explanation of
Microsoft Office

PowerPoint 2019 -

Creating presentations,

Delivering
Chapter Two: Microsoft
Office PowerPoint 2019,

Start Window, Main
Window

the lecture

using the

smart board
and

Group
Assessment

Group
Assessment

Group
Assessment

Group
Assessment

Individual

Assessment

Individual
Assessment

Individual

Assessment



26

27

28

29

30

2 hours

2 hours

2 hours

2 hours

2 hours

PowerPoint uses, Start
window, Home window

Applying the File tab
tools and the Home tab
tools - (Clipboard, Font,

Paragraph, and Slides)

Applying the Insert tab
tools — Illustrations,

and applying the Insert
tool — Links

Applying design tab
tools and animation tab

tools

Explanation of the uses
of computers in the
field of physical

education and their
objectives, the

technical devices used
in the sports field.

Chapter Two: File Tools
and Main Ribbon Tools

Chapter Two: Insert Tab
Tools - (Graphics, Links)

Chapter Two: Applying
Design Tab Tools and
Animation Tab Tools

Chapter Two: The
Introduction of Modern
Technology in the Sports

Field

cooperative
learning.

Delivering
the lecture

using the
smart board

and
cooperative
learning.

Delivering
the lecture

using the

smart board
and

cooperative
learning.

Delivering
the lecture

using the

smart board
and

-xcoperative

Delivering
the Zcture
using the

smart board
and

discussion

Individual

Assessment

Group
Assessment

Group
Assessment

Group
Assessment

Second Chapter Theoretical Exam / 2

Ile Course Evaluation

The grade is distributed as follows:

I. The first semester exam, worth (25) points.

2. The second semester exam, worth (25) points.

3. The end-of-year exam, worth (50) points.
12. Learning and Teaching Resources

Required textbooks (methodology, if
any)

Key references (sources)

- Introduction to computers, their development, and
computer systems and its applications, and the
modern technolo used in the s orts field.

- Windows 10, Mohamed Abu Al-Ala
- The Complete Guide to Learning MicrosoftWord

2019, Wissam Al-Khazai and Wael Al-Kreizi
- Your path to learningMicrosoftPowerPoint 2019,

Wissam Al-Khazai



Recommended supporting books and
references (scientific journals,
reports...)

Electronic references, websites

- The computer, Windows 10, Office applications,
modern technology in the sports field.

- Sports education and training technology, and what
has it achieved? A report by Ishraqat Al-Sayed,
2022, EdTech Arabia.

- Technology is taking sports into the future, report
By Salah A1-Kumari 2021, SNRT NEWS

Name and signature of the course holder

Assist. Prof. Dr. Mohammed Hazim Alkawaz

Lect. Rehab Joko Hussein

Assist. Lecturer Saif Khalid Jarallah

Assist. Lect. Salwa salahaldeen Qasim

Assist. Lect . ghazwan mohammed

Name and signature of the head of the department or branch

Prof. Dr. Nawfal Fadel Rashid


